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1) What is freezing panes? 
To freeze the top horizontal pane, select the row below where we want the 

split to appear. 

1. To freeze the left vertical pane, select the column to the 

right of where we want the split to appear. 

2. To freeze both the upper and left panes, click the cell below 

and to the right of where we want the split to appear. On 

the Window menu, click Freeze Panes 

 

2) What are the primary groups? 
i. Capital Account 

ii. Reserves and Surplus 

iii. Current Assets 

iv. Bank Accounts 

v. Cash-in-Hand 

vi. Deposits 

vii. Loans and advances 

viii. Stock in Hand 

ix. Sundry debtors 

x. Current liabilities 

 

3) How to set or alter budgets? 
a. There are three options to set or alter budgets 

b. Group 

c. Ledger 

d. Cost Center 

e.  

4) Write the sub-groups of current asset? 
There are six sub-groups to current assets. 

 Bank Accounts 

 Cash-in-Hand 

 Deposits 

 Loans and advances 



 Stock in Hand 

 Sundry debtors 

 

5) What is a Profit and loss account? 
Profit and Loss Account will display the Net profit or loss of the company for 

the current financial year.  Select profit and loss account from Gateway of Tally. 

 

 

6) What is Automation? 
The computers do the calculations or manipulation on the data automatically 

by using instructions.  The instructions not only relate to arithmetic operations such as 

multiplication, division, etc but also logical decision such as right or wrong. 

 

7) Trial Balance. 
The periodical monetary events summary is known as Trial Balance.  In 

double entry system for every transaction, Debit aspect always equal to Credit aspect. 

The detailed trial balance shows the groups and subgroups or ledgers and subgroups 

or ledgers under them. 

 

8) What is Purchase order? 
Purchase orders may be produced printed and sent to suppliers.  Goods 

received are linked with the Pos and invoices.  Outstanding purchase orders should be 

monitored. 

 

Purchase order details will also depend on configuration settings. 

From Gateway of tally > select voucher Entry > select purchase order. 

 

       9) Explain Voucher entry 
Press relevant button at voucher creation screen to select particular type of 

voucher. 

Basic voucher types available in tally are: 

 Receipt voucher F6 

 Payment voucher F5 

 Purchase voucher F9 

 Sales voucher F8 

 Contra voucher F4 

 Journal voucher F7 

 Memorandum F10 

 

     10)  Write any 4 shortcuts keys? 

 

Ctrl + A, Alt + F4, Ctrl + Del, Ctrl + S. 

 

11) How to Edit and Delete stocks items? 
 



Editing stocks: 

Location: Inventory Info/Stock Items 

Shortcut: I, I, A 

Upon selection of stock item from pop-up menu we can alter any data. 

Deleting Stocks: 

Once created stock item can be altered and deleted.  To delete a Stock, 

select item in Alternation mode and press Alt + D, is would be deleted provided 

no voucher has been created for it. 

 

 

 

12) Columnar reports: 
 

Tally provides columnar reports in sales, purchase and journal registers as 

well as ledgers and cash, bankbooks. 

 

13) Explain Inventories? 

 
The inventory control application should provide high quality service to its 

customer by utilizing fast, accurate and efficient method of filling customer’s 
orders and avoiding stock outs. 

 

     14) Accounts receivable/payables: 

 

Tally provides complete bill-wise information of amounts receivable form 

sundry debtors as well as amounts payable to sundry creditors. 

 

15) Voucher scheme and numbering scheme: 
 

Tally provides 23 predefined voucher types.  We can set voucher numbering 

as per our need as automatic, manual or none. 

 

   

16) What are the ways to consolidate data? 
 

We can consolidate data in many ways. 

 

a. Consolidate data by using 3D reference. 

b. Consolidate data by position 

c. Consolidate data by category etc. 

 

       17) How to run an application? 
 

i. To start a program by using the Run command 

ii. Click Start, and then click Run. 



iii. In the Open box, enter the location and name of the program we 

want to start 

 

 

18) Explain computerized accounting. 
 

Accounting is the language of business.  It involves identifying, measuring, 

and presenting economic information about a business.  Accounting has been 

defined as the art of recording, classifying and summarizing in a significant 

manner transaction and events, which are of financial character and interpreting 

results. 

 

19) Contra voucher? 
 

Cash or cheque deposited into bank, cash withdrawn from bank, transfer 

of funds from one bank account to another will be entered through contra 

voucher.  Debit and credit accounts can only be cash and Bank accounts.  By 

pressing function key F4, we can enter contra voucher. 

 

20) Explain any two vouchers? 
 

Receipt Voucher: 

Receipt voucher is used to enter all receipts of cash or bank.  The amount 

received from the sale of fixed assets must also be treated as Receipts. By 

pressing the function key F6 we can enter the receipt voucher. 

Sales Voucher: 

Sales voucher is meant for sale entries.  Sales made in the regular course 

of business will be entered in this voucher.  By pressing the function key F8, we 

can enter a sales voucher. 

  

21) What is a spreadsheet? 

 

A spreadsheet is a table of values arranged in rows and columns.  Each 

value can have a predefined relationship to the other values.  If we change one 

value, we may need to change the other values as well. 

 

22) How will you create table? 
 

Create a table by using the Insert Table command, or use the Draw Table 

tool to create a more complex table; for example, one that contains cells of 

different heights or a varying number of columns per row. 

 

23) How to save a document? 
 

To save a document on first time we can use File -> save command or 

icon is clicked. 



 

24) What is an Operating system? 
 

An OS consists of a series of programs, which control, coordinate and 

supervise the activities of various components of a computer.  The OS provides 

links between the user’s program and the computer hardware.  An OS is software 
that forms a bridge between the user and the hardware. 

 

 

 

 

           25) What is Hardware? 
 

Hardware consists of all machinery and equipment in a computer system. 

The hardware includes among other devices, the keyboard, the screen the printer 

and the computer or processing devices itself.  Hardware represents the physical 

component of a computer. 

  

 

26) How to Create Shortcuts? 
 

Right click the item and we can create shortcuts for any application, folder 

or files.  Shortcuts can be created in desktop or within that folder or subfolder.  

Shortcuts are created by two methods a) Keyboard shortcuts b) Desktop shortcuts. 

  

       27) Write the Icons on Desktop. 
 

Desktop has several icons.  Icons are small pictures/images representing 

applications.  Each icon has a label telling us the name of the application it 

represents E.g. my computer, Recycle bin, Internet Explores etc. 

 

             28) What are the different types of Word Document? 
 

There are several types of Word Documents. 

Blank Document _ To create a traditional document. 

Web page – We can display the contents in a web browser. 

E-Mail messages – We can compose and send a message to others directly 

 

                29) What is meant by Control Unit? 

 
It manages the operation of the entire system.  This circuit directs the 

movement of electronic signals between memory, which temporarily holds data, 

and instruction.  This memory is non-volatile.  Processed control unit supervises 

every operation within the CPU and co-ordinates all the activities. 

 



            30) I-P-O Cycle? 
 

Input Process Cycle is the basic for most activities.  For example, 

take a car assembly line.  This activity constitutes the input part.  The 

process is the actual building of the car.   

 

            31) What is budgetary control? 
Budgets are used to set targets and compare against actual and get 

variances.  The use of budgets to control day-to-day operations can be an 

educative task as well as a beneficial one.  Tally gives the facility to fine tune our 

control of budgets over Ledger accounts, groups of accounts and cost centers. 

 

32) Define Computer. 
 Computer is defined as an electronic device that can accept data, process 

information in a predefined fashion.  It works according to the set of instructions 

provided to it and produces desired output. 

 

33) What is Logging on? 
 Windows is a multi user operating system.  Several users can access the 

different applications.  There may be an administrator controls all the users and 

other users.  An administer can be provided with different log on and password 

and other users with different log on. 

 

34) What is an Inventory report? 
 Inventory reports are prepared based on the voucher. All the reports have 

default format, which can be changed by using different buttons as per our 

requirements. 

 

35) Define software. 

  Software consists of the instructions that tell the computer how to perform 

a task.  Programs, which are list of instructions, to be executed by a computer are 

known as the software of a computer.  In other words, software is defined as a set 

of programs associated with the operation of a computer. 

 

36) How to configure Tally? 
 Tally can configure options by pressing the button F12.  This button is 

context sensitive.  

 

37) What is Tally Vault? 
 Tally offers data encryption option, which follows Data Encryption 

Standards (DES). 

 

38) What is cost center report? 
 Cost Center report enables us to analyze the net income or expense in each 

cost center. 



 

39) What are the Inserting Objects? 
 We can insert object using 

i. WordArt feature. 

ii. AutoShapes etc. 

 

                   40) Write the meaning of Thesaurus. 
Thesaurus is used to find synonym, an antonym or related words.  On 

the Tools menu, point to Language, and then click Thesaurus. 

 

   SECTION – B 

 

1) Explain Auto Correct. 
 

We can use the Auto Correct feature by selecting Tools menu and 

click Auto correct.  It is used to automatically detect and correct types, 

misspelled words, grammatical errors, and incorrect capitalization.  We 

can also use AutoCorrect to correct errors in another language. 

 

                        Turn on or off Auto Correct options 

 

i. On the Tools menu, click AutoCorrect 

ii. Do one or more of the following: 

o To set the capitalization options, select or clear the first 

four check boxes in the dialog box. 

o To turn on or off the AutoCorrect entries, select or clear the 

Replace text as we type check box. 

o To turn on the spelling checker corrections, select the 

Replace text as we type check box, and then select the 

Automatically use suggestions from the spelling checker 

check box. 

 

To turn off the spelling checker corrections, clear the 

automatically use suggestions from the spelling checker check box. 

 

  2) Explain Complier. 
 

 Complier is a program that translates source code into 

object code. 

 It checks the entire user-written program converts the 

whole into a machine language program. 

 After translating the entire program, it executes the 

program sequentially statement-by-statement and loads one 

statement at a time in core memory. 

 If any corrections occur in it, it asks for rectifications.  

Hence the execution time is less in it. 



 All compiled programs run faster. 

 Any mistakes in the programs cannot be known at the time 

of entering instructions. 

 Objects code is generated here. 

 Useful for compiling large applications. 

Code security – When programs are executed using compilers, the 

code is highly secured.  The basic software on which the application 

software was developed is not needed at the time of implementation.  Thus 

the user has no need in seeing the source code. 

 

  3) What are the Classifications of Computer? 
  Computers are classified usually as, 

a. Digital 

b. Analog 

c. Hybrid 

  Digital computer 

A digital computer is one that directly counts the number.  It represents 

numerals, letters, or other special symbols. 

  Analog computer 

An analog computer is one that measured physical values such as 

temperature or pressure that fall along a continuous scale. 

In contrast to digital computer, analog computers carry out 

operations on data, which can vary continuously.  An analog channel 

transmits digital channel on the other hand, transmits binary digits 

represented by voltage pulses. 

  Hybrid Computers  

Desirable features of analog and digital computers are sometimes 

combined to create a hybrid computing system. 

 

   4) Write the usage of cost category and cost centers in vo 

   voucher entry? 
  

 Tally implements the use of cost centers in a manner which forces the 

full allocation of the relevant amounts to the respective cost centers. 

 Whenever a revenue item is used in a voucher, Tally pops up a small 

box, asking how the amount for the account is to be allocated. 

 We can tag cost categories and cost center to vouchers by 

 Check with the ledger accounts whether we have specified yes to cost 

centers are applicable. 

Select voucher Enter > select suitable voucher > pass the entry 

and tag the cost centers individually. 

 

 

 

 



      5) What are the features of stock items? 
 

To create stock items choose Gateway of Tally > Inventory Info > Stock 

Items. 

 

To configure stock item settings press F12. 

a. Advanced Usage: This section deals with the additional fields we 

would input during the creation of a stock item. 

b. Part No: This is option.  To give part number for the item to identify 

them in certain industries Example:  In automation industry, various 

parts are known by their number. 

c. Alias: We are allowed to give aliases for the part number. 

d. Description: Give a description of the stock item that would appear in 

our invoices. 

e. Category: Classify stock items into stock categories. Modify 

previously created stock items to assign them to stock categories. 

f. Remarks: This is to identify the products or its usage when we look at 

its details. 

g. Alternate units: This is another unit, apart from the main unit, that we 

can use for the stock item.  This is useful when we need to deal in 

different units at different times. 

h. Enter Standard Rates: If we wish to specify standard purchase and 

sales rates for the item, select yes. 

i. Costing method: Select the method of valuation for the entry.  

 

                     6) Explain Tally locker? 
 

        It is a small external hardware device.  We can store data and work 

directly at Tally locker. When the task is over, we can simply pull it and 

slip it into our pocket. 

 

Other features of Tally: 

i. We can import and export data from tally.  It imports data in SDF 

and XML format.  It exports data in ASCII (American standard 

code for information interchange), SDF and XML (Extensible 

Markup Language) formats.  It reports in HTML (Hypertext 

Markup Language) format. 

ii. Tally is Open Database Connectivity (ODBC) compliant. 

iii. Tally is a web-enabled tool. 

 

            7) Write the Fundamentals of computerized accounting? 
 

Accounting is the language of business.  It involves identifying, 

measuring, and presenting economic information about a business.  The 

users of the information can form opinions about the business, judge its 

performance and take certain decisions. 



 

Accounting has been defined as the art of recording, classifying 

and summarizing in a significant manner transaction and events, which are 

of financial character and interpreting results thereof. 

 

Computerizing any function in organization results in reduced 

operation costs, increased efficiency and minimized errors.  Repetitive 

entry of input is avoided.  The laborious process of repetitive compilation 

is done by the computers.  User-friendly application software helps in 

generating any type of reports at the flick of a key. 

 

Organization introducing computers invariably start with the 

accounting function, since accounting is performed in a fairly consistent 

and uniform way. 

 

Financial accounting software is used to store and maintain daily 

business transactions like purchases, sales, receipts, payments, purchase 

returns, sales returns, deposits and withdrawals.  Tally is one of the most 

popular packages used for this purpose. 

 

In FA, we should be able to distinguish between debit and credit in 

a transaction. 

  

    8) Explain Daybooks? 
 

Day Book lists all the vouchers we have entered.  It is the best 

place to locate any voucher.  By default, it lists all the vouchers we entered 

on current date.  Daybook is used to display the vouchers entered.  We can 

also verify whether the voucher is entered correctly or not.  If the voucher 

entry is wrong, it can also be corrected.  If duplicate vouchers exist, such 

vouchers can also be deleted. 

To display the Day Book, select Display from Gateway of Tally 

menu, and then select Day Book.  To view the actual entries in detailed 

Day Book, press Alt + F1.  To view the Day Book of the specific date, 

press F2, type a date and press enter.  Alt +F2 is used to displaying Range 

of date. 

 

Configuring Day Book: 

 To change the configuration of day book, press F12. 

In the configuration, we can see the following things: 

a. Whether the narration of voucher is to be displayed 

or not. 

b. Type of vouchers to show 

 

c. Sorting method – alphabetical or Amount Wise. 



To alter a voucher, select voucher from Day Book menu.  Make 

necessary changes. 

 

To delete a voucher, select the voucher from the day book.  Press 

Alt + D to delete the voucher and confirm Delete? Yes. 

 

Printing Day Book: 

To print a Day Book first display it on the screen and then press 

Alt + P.  If the options are set properly, press Y to print. 

 

9) What is balance sheet? State about configuring balance 

sheet? 
Balance Sheet: 

A Balance sheet is a statement of the financial position of the 

company.  It displays the capital, assets and liabilities of the company.  

Balance sheet is the ultimate report of the financial Accounting system. 

The result of all transactions finally conveyed into the balance 

sheet.  To display the balance sheet, select balance sheet from Gateway of 

Tally menu. 

By default balance sheet will be displayed in double columnar 

horizontal format with the closing balances of primary groups and 

Liabilities. 

To view the detailed balance sheet presses Alt+F1.  To view the 

balance sheet for particular period presses F2. 

  To closing stock in balances sheet press F7. 

 

Configuring Balance Sheet: 

Pressing F12 can configure the balance sheet. 

 Balance sheet can be displayed in horizontal format or in vertical 

format. 

 In order to view the Balance sheet figures with their percentage 

break ups, select show percentage yes.  Default is No. 

 Instead of representing current Assets and Liabilities separately, 

to present working capital Analysis, select show working capital 

figures? Yes. 

 By default, the balance sheet will display the liabilities on the left 

and Assets on the right side.  We can alter order by selecting the 

option from Method of showing balance sheet. 

 Different scale factors for values are available to round off the 

balances to the nearest crores, lakhs, hundred etc. 

 

10) What is the use of Briefcase? 
 By using Briefcase, we can synchronize files connected computers.  

It can be done when computers are connected.  We can open the briefcase 

on our portable computer and coy the appropriate files from our main 

computer. 



i. Work on the files on our portable computer. 

ii. When we have finished working if they files connect the two 

computers if they were disconnected, open Briefcase on our 

portable computer, and then do one of the following: 

 To update all the files, click the Briefcase menu, and then 

click Update All. 

 To update only some of the files, select the files we want 

to update, click the Briefcase menu, and then click 

Updated selection. 

 

Using My Briefcase to keep our files synchronized 

 If we want to work on files at home or on the road, we can 

use My Briefcase to help keep the various copies of our files 

updated 

To open My Briefcase, double-click My Briefcase on the 

desktop. 

   

 11) What is Desktop and Taskbar? 
Desktop 

The Desktop is the workspace that appears our screen.  It has 

several icons.  Icons are small pictures/images representing applications.  

Each icon has a label telling us the name of the application represents.  

Example: My computer, etc. 

We can use the desktop for almost any such as opening programs, 

copying files, connecting to the internet, reading our e-mail, and so on.  

The improved windows 98 desktop is designed for easy performance of 

everyday tasks and for complete Internet integration. 

 

Taskbar 

The taskbar is usually a narrow gray strip present at the bottom of 

the screen.  On the left it has the Start button.  When we click the button, 

the start Menu appears on the screen.  We can start any application that we 

want using start menu.  Right side to start button is the Quick Launch 

Toolbar.  It contains icons that allow us to select some commonly used 

applications. 

 

12) Write the advantages and disadvantages of High-level 

Language? 
It is otherwise referred to as “procedure-oriented language (POL)”. 

The limitations of machine and assembly language were overcome by a 

set of new language called “High-level Language”.  It resembles English 
language in syntax and uses common mathematical symbols, which makes 

the job of the programmer easier. 

 

Example: COBOL, BASIC, ALGOL, PASCAL, C etc. 

 



Advantages: 

i. It is easy to use and learn 

ii. The syntax is similar to commonly used languages.  So the 

writing of program is easy. 

iii. It is user-centered. 

iv. They are machine-independent and hence a High-level Language 

program can be done on different systems with little or no 

modification. 

v. The programmer need not be familiar to the machine characters. 

vi. They require less effort. 

Disadvantages: 

i. They have to be translated into machine readable codes before 

execution 

ii. Translation consumes extra time and hence less efficient than the 

low level languages programs are available for converting into 

machine codes and they are known as “compilers”.  

     

13) How will you create Stock items? 
Stock items are the actual items that are transacted, received, 

issued or produced and take part in any inventory voucher.  Stock items 

are normally placed under stock groups and categories. 

Like ledgers, stock items are the primary inventory entity.  We will 

use stock items while recording their receipts and issues.  Each item that is 

required needs to be created.  We create stock ledger account for each 

item.  Tally calls this account as “stock item”. 
Stock items are actual items in the stock Example: cooks, pens, 

pencils, cables, papers etc, which are purchased and sold in the business.  

The quantity and rate of each item can be entered to each stock item, when 

making the purchase or sales entry. 

The information entered is two types: 

1. Normal information 

2. Advanced information 

In Normal information the things entered are: 

Name, Alias, part no, remarks, Enter standard rates, rate of duty, 

tariff classification, set components and opening balance. 

In advanced information the additional information like: 

Costing method, market valuation method, ignore difference due to 

physical counting, ignore negative balance, treat all sales as new 

manufacture, treat all purchase as consumed, treat all rejection inward as 

scrap, and allow use of expired bathes, entered. 

 

 

   

 

 

 



   14) Explain Memory and control unit. 
Central processing unit (CPU) 

The central processing unit is the brain of the computer.  It 

processes data, store them, controls the interpretation and execution of 

instructions.  It is composed of three important units. 

 

a. Arithmetic and logic unit 

b. Control unit 

c. Memory unit 

Arithmetic and logic unit 

Arithmetic and logical operations are performed by ALU.  

Arithmetic operations include addition, subtraction, multiplication and 

division.  Logical operations consists of comparisons. 

Control unit 

It manages the operation of the entire system.  This circuit directs 

the movement of electronic signals between memory, which temporarily 

holds data, and instructions.  This memory is non-volatile. 

Processed control unit supervises every operation within the CPU 

and co-ordinates all the activities.   

Memory unit 

This unit holds all data, instructions and intermediate results.  It is 

otherwise referred to as main memory or “Primary storage” or “Internal 
storage”.  The internal storage consists of a set of microchip connected by 
very fine wire. 

.  

 

  15) Write any three Direct-Input devices. 

Voice input and speech recognition: 

 New methods to enter data at rapid rate are becoming 

popular; voice input is one such method, which does not 

require keyboard skills and technical training. 

 This technology allows the computer not only to record 

voice input but also to understand speech into electrical 

signals. 

 

Joystick: 

 It is a positioning device. 

 A small cursor displayed on the screen moves in response 

to users manipulation of the joystick 

 Mostly used in playing computer games 

 

Light pen: 

 It is a pointing device. 

 If it is pointed at anywhere on the screen, the computer can 

identify the specific location to which the pen is pointing 

and determines the item selected by the user. 



 

16) Give an introduction to vouchers. 

 Voucher is a document containing the details of a transaction.  For 

every transaction we make a voucher.  The voucher entry option at the 

Gateway enables us to make day-to-day entries. 

 To make voucher entry, the accounts are broadly classified into 3 

types 

 

Personal accounts- Accounts related to person, normally accounts related 

to names such as Hassan (p) Ltd. 

 

Real Accounts- Accounts related to tangible and visible things such as 

cash, all types of assets like land, buildings etc. 

Nominal Accounts- Accounts related to intangible and invisible things, 

which do not have a specific shape. E.g. all income and expenses. 

 

17 Write the advantages of using windows 98.)  

 

o It is a user friendly operating system.  It displays all information on 

the screen and we can point out information and can select any by 

mouse. 

 

o It can run two or more applications at the same time. 

 

 

o It has an excellent internet interface.  With Windows 98, we can 

easily access and browse through web pages from anywhere on our 

computer. 

 

o Windows 98 inherits the features of Windows 95 as a powerful 

desktop operating system. 

 

 

o Windows 98 makes the web as an extension of the user’s desktop. 
 

o Windows 98 is more reliable, faster, tightly integrated with web 

and fun to use. 

 

o Windows 98 has the built-in support for the latest hardware and 

software 

 

 

18) How to use tally in Bank reconciliation statement? 
BANK RECONCILATION STATEMENT 

 Bank reconciliation means that the accounts maintained by the 

banker tallies with the bank ledger account. 



Tally in reconciliation mode displays in condensed format showing 

date, Ledger account name, voucher type, Debit or credit amount but to 

identify an entry, we need to see cheque numbers to easily match with the 

Bank statement.  Press F12 to configure, select detailed format, and 

respond yes to the query show narration also. 

To entering the Bank date selects the Bank Book under display and 

select the bank we want to reconcile.  We can even select the Bank option 

through any other option of display example: Balance sheet. 

To skip any entry press up/down key or press enter key.  To accept 

the changes press Ctrl + A. 

 

 

19) How will you generate and print reports in detailed and 

condensed format? 

 

Tally prepares the books of account and financial statements base 

don the vouchers entered.  The appearance of reports can be changed 

accounting to the requirements.  The reports can be displayed on the 

screen as well printed on the paper.  General reports, which are prepared 

by Tally, are: 

 Ledgers 

 Cash and Bank Books 

 Purchase, Sales and other Registers 

 Trial Balance 

 Profit and Loss Accounts 

 Balance Sheet 

 Stock Statement 

 Ledger and Summaries 

 Stock item summaries 

 Group summaries  

 Cash and Fund flow statements 

 Cost center analysis etc. 

The purpose of putting all our data is to present them in the form of 

comprehensive Accounting and Inventory reports. 

All we do is entering vouchers and we get all reports readily based 

on these transactions. 

We are also able to retrieve a wide variety of information at a press 

of a key.  The printing screen consists of 3 parts:  The top of the screen 

consists: 

i. The method of Output. 

ii. The Title and Sub-Title, if any, for the report. 

iii. The Date Range applied to this report. 

 

 

 

 



                20) How will you Edit Word Documents? 
Editing is the act of making alterations in the content of a 

document.  To edit a document Cut, Copy, Past, Find and Replace, insert 

and delete spelling checker, grammar checker, thesaurus are some of the 

common editing function. 

Insert and delete: Inserting is the act of adding to the document.  We can 

simply place the cursor wherever we want to add text  

Deleting is the act of removing text, using delete or Backspace 

key.  The delete keys delete the character form the current position. 

Backspace key delete the character to the left of the cursor.  Undo 

command allows us to restore a deleted text. 

Find and replace: Find or search command allow us to find any word, 

phrase, or number that exists in our document.  Replace allows us to 

automatically replace it with something else. 

Cut Copy and Paste:  We can use the copy or cut command to move it to 

a special area in the computer’s memory called the clipboard.  We can 
paste or transfer anywhere in the existing document or in a new document 

from the clipboard. 

 

 

 

 


